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Chapter 1.

Chapter 1. Introduction

This chapter introduces the modules in charge of the BPM functionality inside the Kie Workbench.
These modules were grouped under the name of JBPM Console NG and they can be found
here: http://github.com/droolsjbpm/jbpm-console-ng . Inside the GitHub repository will also find
a standalone version of these modules integrated with some authoring tools, like for example
the Process Designer and the Form Designer, as well as some common tooling to explore the
business repositories. If you are interested in a full integrated environment that provides Form
Modeling, Data Modeling, Rules Authoring, etc, you should take a look at Kie Workbench which
provides all the functionality discrived in these docs plus all the mentioned above.

1.1. Documentation Sections

This documentation is organized into different sections that reflect the project internal structure.
The main goal of this document is to explain the functional aspects of each of the following modules
as well as to server as reference for developers that wants to customize or extend the provided
functionalities.

1. Process Runtime: This module contains all the tools to create and manage process definitions
and process instances.

2. Tasks: This module provides all the Human Tasks related functionality. This module is
integrated with the Form Modeller to provide a unified experience, so users can work on the
tasks that are assigned to them.

3. Deployments: This module contains all the functionality related with the management
of deployment units, that represent packaged business assets ready to use in runtime
environments.

4. Jobs: This module provides all the functionality to schedule async Jobs using the jBPM Executor
module.

Notice that on these documents the common infrastructure screens are not explained. If you are
interested in finding more information about Process Designer, Project Explorer, Form Modeller
and other modules please check the jBPM Documentation.
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Chapter 2. Process Runtime

This chapter describes the screens related with the creation and management of process
definitions and process instances.

Once you have modelled and configured all the techncial details to run a process definition your
process definition will appear in the Process Definitions List. Once you have the process in the
Process Definition List, you can start new instances of it. The following sections describes the
features provided by each of these screens. You can find these screens under the Process
Management Menu, in the jBPM Console NG or in Kie Workbench.

You can find the source code for this module here: https://github.com/droolsjbpm/jbpm-console-
ng/tree/master/jbpm-console-ng-process-runtime

Process Management ~

Process Definitions

Process Instances

2.1. Process Definitions

The process definition section is composed by two main screens: the Process Definition Lists and
the Process Definition Details.

2.1.1. The Process Definition List

The process definition list shows all the available process definitions that were deployed into
the platform. Look at the Deployments section for more information about how to check all the
deployment units available.

Process Definitions Refresh | % ¥
Name Version Actions
Evaluation 1 ® Q
Hiring a Developer 1 ® Q

1202 4 M M M
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You can click in the list rows to access to the details of the process definition.

2.1.2. The Process Definition Details

The process definition details shows all the available information about the process definition. You
can consider this screen as a brief about the process model. You can quickly see if there is a
Sub Process associated with it, or how many users and groups are participating in the selected
definition.

Process Definitions refresh x|~ Details New Instance | Options * | Refresh | | % ¥
Name Version Actions
Definition Id  hiring
Evaluation 1 ® Q
Definition Name  Hiring a Developer
Hiring a Developer 1 ®Q

Deployment  org.jbpm:HR:1.0

Human Tasks  Sign Contract
Create Proposal
Tech Interview
HR Interview

Human Task Count 4

User and Groups  HR - Sign Contract
Accounting - Create Proposal
IT - Tech Interview
HR - HR Interview

Sub Processes

1-20f2 M K M M
Process Variables  skills - String

twitter - String
mail - String

Notice that you can View the Process Model (Read Only mode) using the Options Menu in the
top bar. You can also look at all the process instances for the selected process definition goint
to Options -> View Process Instances.

2.1.3. Creating Process Instances

You can create new Process Instances from the Process Definition List or from the Process
Definition Detail view.

Hiring a Developer

“Candidate Mame




Creating Process Instances

When you want to create a Process Instance usually a Form will be presented to introduce the
information required by the process to be started. Once you complete the form and click into the
Start Process button, the instance will be created and the details of the Process Instance will be
displayed on top of the Process Definition Details.
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Chapter 3. Tasks

This chapter introduces the Task Management screens and the its integration with the Form
Modeller component to allow users to work on their assigned tasks. You can find the source code
of these screens here: https://github.com/droolsjbpm/jbpm-console-ng/tree/master/jopm-console-
ng-human-tasks

3.1. Task List

Every user with access to the platform will have access to its personal task list where tasks
assigned to him/her will be displayed. Each user will be able to create its own personal tasks or
work on tasks that were create as a result of a business process execution.

You can access to the Task List under the Work main menu:

Work - Dashboards

Tasks List

3.1.1. Task List (Personal and Group Tasks)

Pending tasks can be displayed using different methafors depending on what the user is interested
on. We are currently providing two different views explained in the sections below: Grid and
Calendar View.

3.1.1.1. Task List (Grid View)

If you are interested in having a tabular view of all the pending tasks for a specific person or
group you can use the Grid View. The list will show all the pending tasks ordered by the columns
presented. You can change the default ordering clicking on the column header.
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Tasks List

Grid Calendar

New Task

Refresh | %

Active = Personal Group Al

Id Task Priority Status Created On Due On Actions

5 Attend to important Meeting 0 InProgress 04/10/2013 13:15 05/10/2013 13:15 ﬂ v 4 Q

4 Write Month Report 0 InProgress 04/10/2013 13:15 05/10/2013 13:14 a \/ Q

3 Weekly Check Stock 0 InProgress 04/10/2013 13:13 05/10/2013 13:12 ﬁ v 4 Q

2 Approve Invoice 0 InProgress 04/10/2013 13:12 05/10/2013 13:12 a v Q

1 Call a Customer 0 InProgress 04/10/2013 13:12 05/10/2013 13:12 ﬁ v Q
1505 M4 H M M

3.1.1.2. Task List (Calendar View)

If you want a more time oriented view of your pending tasks you can use the Calendar View.
This view arrange the tasks based on the Task Due Date. You can switch between three different

ranges: Day, Week or Month.

The Day view shows all the tasks that Due Today. Notice that you can change the selected date
using the calendar or using the Next and Previous button. The Today button will be enabled when
you are in a different day than today, and when you click it it will return the selection to the current

date.

Tasks List

Grid Calendar Wed, 09 October B
A Wed 9 (5)
08:57AM  Call Customer
Approve Invoice
Weekly Check Stock
Write Month Report

Attend to Important Meeting

The Week view shows all the tasks pending for the current week. You can change the selected
week using the calendar or the Next and Previous button. If you click on the Today button, you

< Today i

Day

Week Month

will be moved to the week the current week.

New Task

Refresh x

Active | Personal  Group  All

sEEE D
| I (N
EEkEkE~




Task Details

Tasks List New Task || Refresh | | % | ¥
Grid = Calendar 07 Oct - 13 Oct B8 4 | Today | » Day = Week  Month Adive | Personal = Group Al
¥Mon 7 (0) % Today Tue 8 (0) A Wed 9 (5) A Thu 10 (1) A Fri 11 (1) ¥ Sat 12 (0) ¥5un 13 (0)
Call Customer Technical Interview ‘ ‘ After Office 06:00 PM

Approve Invoice

Weekly Check Stock

Write Month Report

Attend to Important...

The Month view shows all the tasks that due on the selected month. You can change the month
using the calendar or the Next and Previous button. If you click on the Today button the calendar
will show all the tasks that due in the current month.

Tasks List NewTesk | Refresh %~
Grid |~ Calendar October 13 f | ¢ | Today  » Day Week | Month Active | Personal | Group | Al

¥ Mon 30 (0) ¥ Tue 1(0) ¥ Wed 2 (0) ¥ Thu 3 (0) ¥ Fri 4 (0) ¥ Sat 5 (0) ¥ 5un 6 (0)

¥ Mon 7 (0) ¥ Today Tue 8 (0) | [carcustomer | AWed 9(5) | W rechnical terview® Thu 10(1) | M arer omoe AFri11 (1) ¥ Sat 12 (0) ¥ Sun 13 (0)

Approve Invoice

Weeiy Check Stock

ictte Moth Benoct

¥ Mon 14 (0) ¥ Tue 15 (0) ¥ Wed 16 (0) ¥ Thu 17 (0) AFri 18 (1) * Sat 19 (0) ¥ 5un 20 (0)
Dog Training

¥ Mon 21 (0) ¥ Tue 22 (0) ¥ Wed 23 (0) ¥ Thu 24 (0) % Fri 25 (0) * Sat 26 (0) ¥ 5un 27 (0)

¥ Mon 28 (0) ¥ Tue 29 (0) ¥ Wed 30 (0) ¥ Thu 31 (0) ¥ Fri 1 (0) ¥ Sat 2 (0) ¥5un 3 (0)

3.1.2. Task Details

You can access to the Task Details by clicking in a task row (in both Grid and Calendar Views).
The details associated with a task can be changed, like for example the Due Date, the Priority
or the task description.
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Tasks List MewTask Refresh %  +  Details Work  Detalls  Assignments ~Comments | X ¥
Grid | Calendar Acive | Personal | Group | Al
Details
Id Task Priority Status Created On Due On Actions
ion Reom A - Floor 17

5 Attend to important 0 Progress 041020131315 051020131315 @ W Q Description

Meeling
4 Write Month Report | 0 IProgress 041020131315 051020131314 G o Q Status  InProgress
3 Weekly Check 0 nProgress 041022013 13:13  05M02013 1312 (@ W Q DueOn  2013/10/06 13:15

Stock

i . Priority 0 - High ~|

2 Approve Invoice 0 Progress 0410220131312 051020131312 @ W QU o
1 CallaCustomer 0 IProgress 041020131312 051020131312 G o Q User katy

Process Context

Logs

15065 M H W M Update

You can also view the Process Context for a specific task. If the task was created by a Business
Process, you will have access to see the Process Instance status that has created it.

Details Work | Details | Assignments  Comments %"

9 - HR Interview

Details

Process Context

Process Instance Id 1

Process Definition Id  hiring

Process Instance Details Process Instance Details

Logs

LUpdate

10



Work on a Task

Finally you can see the Task Log, which allows you to see all the operations that has been
executed on the task since its creation.

Details Work Details Assignments = Comments ® T

.........................

5 - Call Customer

Details

Process Context
Logs

Task Log

08/10/2013 08:57: Task - ADDED (katy)
08/10/2013 08:57: Task - STARTED (katy)
08/10/2013 09:59: Task - RELEASED ()

08/10/2013 09:59: Task - CLAIMED (katy)
08/10/2013 09:59: Task - STARTED (katy)

Lpdate

3.1.3. Work on a Task

Tasks can have associated a Form to store data. If tasks are part of a Business Process, usually
some data needs to be collected and propagated to the business process for further usage. For
that reason, tasks has to provide a way to gather and store data. Forms can be created for specific
tasks using the Form Modeller. If no form is provided a dynamic form will be created based on
the information that the task needs to handle. If a task is created as an ad-hoc task (not related
with any process) there will be no such information to generate a form and only basic actions will
be provided.

11



Chapter 3. Tasks

Details . Work | Details  Assignments Comments

.....................

9 - HR Interview

Candidate Name
salaboy

Age
Ermail

Score

3.1.4. Task Assignments

You can Delegate tasks to different people when you are not able to work on them.

12



Task Comments

Details Work | Details  Assignments | Comments ®| T

5 - Call Customer

Details

Potential Owners  [User:katy]

User or Group [53]3‘30?1

Delegate

3.1.5. Task Comments

You can add comments to your tasks to keep track of the progress or to keep information related
to the task. Notice that if you delegate the task other users can also add comments helping on
the collaboration to complete the task.

13
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Details Work  Details  Assignments = Comments x | T

5 - Call Customer

Add Comment
Comment
Added By At Comment
katy 08/10/2013 09:56 Meed more @
information about
this customer
katy 08/10/2013 09:56  ask for product X @

3.2. New Task (Ad-Hoc Task)

As mentioned in the introduction a User can create their own tasks, which will not be associated
with any Business Process. These tasks can be used to keep track of your personal list of TO
DOs. You can also create tasks and assign them to different people in your team or group.

14



New Task (Ad-Hoc Task)

New Task

Task Name |Buy wife's Birthday Gift

Auto Assign ToMe [

Advanced
Due On 07M10/2013 10:10
Priority O - High
Add User Add Group
User | salaboy

15
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Chapter 4. Deployments

This chapter introduces the Deployment administration screen. Technical users will be able to
check which deployment units are deployed into the platform and available to use. You can find the
source code of these screens here: https://github.com/droolsjbpm/jbpm-console-ng/tree/master/
jbpm-console-ng-business-domain

4.1. Deployment Units List

You can access to the Deployment Units List under the Runtime menu (TODO: fix image and
menu hame)

Deploy - Process M

Deployments
Jobs

The Deployment Unit list shows all the Deployment Units deployed into the platform that are
already enabled to be used. Each deployment unit can contain multiple business processes and
business rules. By default the list is populated by Building and Deploying a KIE Module using the
Project Editor Screen. When you Build and Deploy a

Deployment Units New Deployment Unit | Refresh % ¥

Deployment Group ID Artifact Version Kie Base Name Kie Session Name Runtime strategy Actions

orgjbpm:Evaluation:1.0  org jopm Evaluation 1.0 DEFAULT DEFAULT SINGLETON @

org jopm:HR:1.0 org jopm HR 1.0 DEFAULT DEFAULT SINGLETON (%)

1-20f2 W4 M M M

You also have the option to deploy custom Deployment Units with other options different from the
defaults. When a KIE Project is deployed, by default the "DEFAULT" KIE Base and KIE Sessions

17



Chapter 4. Deployments

are used and the SINGLETON Strategy is used. You can select a different KIE Base and KIE
Session using the New Deployment Unit.

Deploy a New Unit

Group ID
Artifact

Version
KIE Configurations
Runtime strategy | Singleton j

Kie Base Name

Kie Session Name

Deploy Unit

18
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Chapter 5. Jobs

5.1. Jobs (Asynchronous Jobs)

TBD

19
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Chapter 6. Tutorials

6.1. Introduction

This section shows different examples that can be cloned directly inside the KIE Workbench
from the JBPM-Playground repository (https://github.com/droolsjbpm/jbpm-playground). All these
examples are high level and business oriented.

If you want to contribute with these examples please get in touch with any member of the jBPM/
Drools Team.

6.2. Human Resources Example

Let's imagine for a second that you work for a Software company that works with several
projects and from time to time the company wants to hire new developers. So, which employees,
Departments and Systems are required to Hire a new Developer in your company? Trying to
answering these questions will help you to define your business process. The following figure,
represents how does this process works for Acme Inc. We can clearly see that three Departments
are involved: Human Resources, IT and Accounting teams are involved. Inside our company we
have Katy from the Human Resources Team, Jack on the IT team and John from the Accounting
team involved. Notice that there are other people inside each team, but we will be using Katy,
Jack and John to demonstrate how to execute the business process.

21
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Chapter 6. Tutorials

Resources

- - -

Interview Interview

et L bt Job Proposal = F“::zg;ggl —P SignContract ~—J=  Twit new Hire —>®

Lt 5 -

Notice that there are 6 activities defined inside this business process, 4 of them are User Tasks,
which means that will be handled by people. The other two are Service Tasks, which means an
interaction with another system will be required.

The process diagram is self explanatory, but just in case and to avoid confusions this is what is
supposed to happen for each instance of the process that is started a particular candidate:

e The Human Resources Team perform the initial interview to the candidate to see if he/she fits
the profile that the company is looking for.

« TheIT Department perform atechnical interview to evaluate the candidate skills and experience.

» Based on output of the Human Resources and IT teams, the accounting team create a Job
Proposal which includes the yearly salary for the candidate. The proposal is created based on
the output of both of the interviews (Human Resources and Technical).

» As soon as the proposal has being created it is automatically sent to the candidate via email.

22



The KIE Project: human-resources

« If the candidate accept the proposal, a new meeting is created with someone from the Human
Resource team to sign the contract.

« If everything goes well, as soon as the process is notified that the candidate was hired, the
system will automatically post a tweet about the new Hire using the twitter service connector.

As you can see Jack, John and Katy will be performing the tasks for this example instance of the
business process, but any person inside the company that have those Roles will be able to claim
and interact with those tasks.

6.2.1. The KIE Project: human-resources

Let's take a look at the Project content in the Authoring Perspective:

KIE Workbench

Explore ~ New Item -  Tools ~ Q
Project Explorer 8 Project: [human-resources:org.jbpm:1.0] Save Build&Deploy | % ¥
example ¥ jbpm ~ human-resources ~ PrOJECt General Settlngs
Project Name Human Resources Example

BUSINESS PROCESSES ijec)c

L Description

hiring
FORM DEFINITIONS

CreateProposal-taskform
hiring-taskform
HRInterview-taskform
SignContract-taskform

TechInterview-taskform

Group artifact version

BrexT FILE
README Group ID org.jbpm Example: com.myorganization.myprojects @
Artifact ID human-resources Example: MyProject @
WORK ITEM DEFINITIONS Version ID 1.0 100 ©
WorkDefinitions -

As you can see it contains the hiring.bpmn2 process and a set of forms for each human task.
You can explore these knowledge assets by clicking on them. You will notice that different editors
will open for different types of assets. If you click on the Business Process file you will be able to
edit the process definition using the Process Designer:

23



Chapter 6. Tutorials

Business Process [hiring] x v
Ev QI:‘;'E_ ﬂ @ = {i_t ol T _5]1' : :«:6: EE o':ao':; :I b B - $v _:)"Jv _¢1r gr I:I -:. H _% b
b Process Modelling Simulation Results “

. HR. Interview Tech Inter'.riewH PKIZ’E?}E;EE?BI HSend Proposal Sign Contract

Feel free to inspect the forms as well. Notice that the Form Modeller will be opened and there you
can edit the forms to fit your requirements.

lorer o Form Modeler [HRInterview-taskform] Save || [
. = Form data origin = =5 Add fields by origin =% Add fields by type | % Form properties [C] Show mode @ Bindings |
jbpm ~ ' human-resources ~ o 50 [100 [t50 fpuo 50 [0 [0 [0 [0 [su0 |50
EHTML'EM' r 6..-e-||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||
— I : ® Candidate Name
E Simple subform > ?
OCESSES = 1 eAge
55 Multiple subform - 3
[ Short text (e )
13 eEmal
TIONS D Long text [ E
17
B 13
posal-taskform O Float ™ i3 escore
cform ) 3 .
o O Decimal [ e =
ew-taskform | O Bigbecimal r~ o
act-taskform [ Biginteger [ ;
. il .|
view-taskform O Short r 3

6.2.2. Building the Human Resources Example

In order to build the Project so it gets available in the Process Definitions List you need to go to
the Authoring Perspective and open the Project Editor panel:

24



Building the Human Resources Example

Explore +  New Item ~ m
Project Explorer

Data Modeler
example ~ jbpm ~ human-resources -

Once you open the Project Editor, you will see on the top right corner of the panel the button called
Build & Deploy. This button will allow you to create a new Jar artifact that will be deployed to the
Runtime environment as a new Deployment Unit.

' [human-resources:org.jbpm:1.0] Save | Build & Deploy

ct General Settings

Name Human Resources Example

Description

Once you get the visual notification that the project was built and deployed successfully you can
go to the Deployments screen to verify that your artifact is there. In order to do that go to the top
level menu called Deploy -> Deployments

Deploy ~

Deployments
Jobs

In the Deployments screen you will find all the deployed units. By default when you Build & Deploy
a project from the Project Editor, it will be automatically deployed using the default configurations.
That is Singleton Strategy, the default KIE Base and the default KIE Session will be used.

If you want a more advanced deployment, that is selecting a different strategy or using non defaults
KIE Base or KIE Session you will be able to undeploy and re-deploy your artifacts using their GAV
and selecting non default options.

25
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t Units New Deployment Unit  Re
Group ID Artifact Version Kie Base Name Kie Session Name Runtime strategy

ation: 1.0 org.joppm evaluation 1.0 DEFAULT DEFAULT SINGLETON

n-resources:1.0 org.joppm human-resources 1.0 DEFAULT DEFAULT SINGLETON

Once your artifact that contains the process definition is deployed, the Process Definition will be
available under Process Management -> Process Definitions.

6.2.3. Create a new Process Instance

In order to create new Process Instances you need to go to Process Management -> Process
Definitions.

Here you will find all the available process definitions in the runtime environment. If you want to
add new process definitions look at the previous sections where it is explained how to build and
deploy KIE Projects.

Authoring -

finitions Refresh %= ~  Details Options' Re

Version Actions
Definition Id  hiring
1 ®Q
Definition Name Hiring a Developer
per 1 @ Q

Deployment org.jbpm:human-resources:1.0

Human Tasks Sign Contract
Create Proposal
Tech Interview
HR Interview

Human Task Count 4

User and Groups HR - Sign Contract
Accounting - Create Proposal
IT - Tech Interview
HR - HR Interview

26



Customer Relationships Example

You can start process instances using any of the two options highlated in the previous screen.

In order to create a new process instance most of the processes will require you to fill in some
information and for that a form will be displayed. For this specific use case the name of the
candidate that we are interviewing is required:

Hiring a Developer

*Candidate Mame

salaboy|

If we hit the big Start button, the new process instance will be created and the first task of the
process will be create for the Human Resources Team. Depending on the assigned roles of the
user that you are using to create the process instance you will be able to see the created task or
not. In order to see the first task of the process we will need to logout tot he application and log
in as someone from the Human Resources team.

After starting the process you can go to the Task -> Tasks section to interact with the created
human tasks. Notice that in order to see the tasks in the task lists you will need to belong to some
specific user Groups. For example the HR Interview task will be visitable for any member of the
HR group, the Tech Interview will be visible by any member of the IT Group.

6.3. Customer Relationships Example

TBD

6.4. Evaluation Example

TBD

27
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Chapter 7. Configurations

There are three points to consider when we configure the application for deployment:

» Users/Groups/Roles
» Domain Specific Tasks (Connectors)

* JBoss AS 7 Profile

7.1.1. User/Groups/Roles

By default the KIE-Workbench uses the JBoss AS configured users to work. In order to create
a new user we need to use the ./add-user.sh script located inside the /bin/ directory. Using this
script we will be creating all the users required by our business processes, and for that reason
we will be also assigning them groups and roles.

Book-Pro:bin salaboy$ ./add-user.sh

user do you wish to add?

nt User (mgmt-users.properties)
ion User {application-users.properties)

tails of the new user to add.
cationRealm)
alaboy

sword

o you want this user to belong to? (Please enter a comma separated list, or leave blank for none) : admin, IT

user 'salaboy' for realm 'ApplicationRealm'

ect yes/no? yes

salaboy' to file '/fUsers/salaboy/MyApps/kie-wb-workshops/jboss—-as-7.1.1.Final/standalone/configuration/application-users.properties’

salaboy' to file '/Users/salaboy/MyApps/kie—-wb-workshops/jboss-as-7.1.1.Final/domain/configurationfapplication-users.properties’

salaboy' with roles admin, IT to file '/fUsers/salaboy/MyApps/kie-wh-workshops/jboss-as-7.1.1.Final/standalone/configuration/application-roles.f
salaboy' with roles admin, IT to file '/fUsers/salaboy/MyApps/kie—wb-workshops/jboss-as-7.1.1.Final/domain/configuration/application-roles.prope

As you can see in the previous image, using the ./add-user.sh script you can create a new user
for the Application User (first two options: option B, and empty realm). Note that you need to use
different strings for the user name and for the password. For now you can create users with role
admin, so it will have access to all the screens of the tool and then you can write the groups
where the user belongs. In this case the user salaboy has Role: admin and he belongs to the
IT group. There are some restricted words that cannot be used as group names. For now avoid

using “analyst”, “admin”, “developer” for group names.

7.1.2. Domain Specific Tasks (Connectors)

Domain Specific Tasks (Connectors) are the way to integrate your business processes with
external services that can be inside or outside your company. These connectors are considered
technical assets and because of that needs to be handled by technical users. Most of the time it is
recommended to not change/modify the connectors when the application is running, and for that
reason these connectors needs to be provided for the application to use in runtime. Three things
are required to use a Custom Connector:
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« Provide an implementation of the WorkltemHandler interface, which is the one that will be
executed in runtime.

* Bind the implementation to a Service Task name.
« Create the Workltem Descriptor inside the tool.

In order to provide these three configuration points you can take a look at the Customer
Relationship example in the jopm-playground repository.

=1

=1

Add Customer
Comment

&

Call Customer
For Comments

&
Obtain

Customer Info

Managers
Report

Create
Customer

The main idea here is to have a separate project that contains the workltems implementations,
for example: CreateCustomerWorkltemHandler , you will need to compile this project with maven
and install the produced jar file inside the KIE-WB application. In order to do that you just copy
the customer-services-workitems-1.0-SNAPSHOT jar into the WEB-INF/lib directory of the kie-
wb.war app. On this example the workltemHandler implementations interacts with a public web
service that you can check here , so you will require internet connection in order to try this example.

Notice also that inside the customer-relationship project there are some high level mappings
of the Domain Specific Tasks that can be used inside our Customer Relationship Project ->
WorkltemDefinitions.wid.

lorer ) Work Item Editor [WorkDefinitions] Save || Delete || Rename || Copy
Palette i ; ; .
jbpm ~  customers-relationships ~ fmpor‘( org.drools.core.process.core.datatype.!mpI.type.Strl.ngDataType,
Result import org.drools.core.process.core.datatype.impl.type.CbjectDataType;
DisplayMName [
Parameter [
R "name" : "CreateCustomer”,
5 Definition “parameters” : [
Click on class to import "in_customer_id" : new StringDataType()
TIONS BooleanDataType I,
EnumDataType "displayName" : "Create Customer”,
FloatDataType "icon™ : "defaultemailicon.gif”
IntegerDataType ]
Il ListDataType '
ObjectDataType [ . L .
StringDataType name" : "ManagersReport",
UndefinedDataType "parameters” : [
JEFINITIONS Select icon to add j "Report" : new StringDataType()
nitions ]

Work Item

Metadata

displayName" : "Managers Report®,
"icon” : "defaultemailicon.qif”
1

This configuration will basically add you Service Tasks inside the Process Designer Palette:
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=l Service Tasks

= Managers Report
Log

Email

Get Customer

REST

w & &

Add Customer Comment

The last step is to bind the High Level mapping to their implementation for this
environment. You can do that by adding new entries into the WEB-INF/classes/META-INF/
CustomWorkltemHandlers.conf file, for this example we just need to add the following entries:

“CreateCustoner”: new
org.j bpm cust oner . servi ces. Cr eat eCust onmer Wr kl t enHandl er (),
“ AddCust oner Conment " : new
org.j bpm cust oner. servi ces. AddCust onmer Corment sWor kil t enHandl er (),
“Manager sReport”: new

org.j bpm cust oner. servi ces. Manager sRepor t Wr ki t enHandl er (),

7.1.3. JBoss AS 7 Profile

In order to run the KIE Workbench (or the jBPM Console NG) in JBoss AS 7 you need to run it
with full JBoss AS7 profile, so if you are installing it using a fresh JBoss AS7 please don't forget
to start it using the full profile:

./ standal one. sh —server-confi g=standal one-ful | .xm
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Chapter 8.

Chapter 8. Frequently Asked
Questions

8.1. Frequently Asked Questions

TBD
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Chapter 9.

Chapter 9. Roadmap

9.1. Roadmap

TBD
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Chapter 10.

Chapter 10. Known Issues

10.1. Known Issues

10.1.1. Deployment Timeout

the deployment time out. In some machines and some operating systems the deployment time
could be greater than a minute and that will cause the application server to throw a timeout
exception. In order to override the default configurations you need to edit the standalone.xml file
and add the following attribute:

<subsystem xnml ns="ur n: j boss: domai n: depl oynent - scanner: 1. 0" >
<depl oynent - scanner  scan-i nterval ="5000" relative-

to="j boss. server. base. dir"
pat h="depl oynent s" depl oynent -ti neout ="1200" />
</ subsyst enr

So if your applications are not deploying add the extra attribute: deployment-timeout="1200" to
the urn:jboss:domain:deployment-scanner:1.0 subsystem.
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